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Build a better mousetrap, and the world will beat a path to your door. 
—Ralph Waldo Emerson

Science and technology and the various forms of art, 
all unite humanity in a single and interconnected system. 
—Zhores Aleksandrovich Medvede

Welcome to the dynamic world of Android smartphone and tablet app development with
the Android Software Development Kit (SDK), the Java™ programming language, the
Android Development Tools IDE, and the new and rapidly evolving Android Studio. We
present leading-edge mobile computing technologies for students, instructors and profes-
sional software developers. 

Android How to Program, 2/e
With this unique book—the second edition of the world’s first Android computer science
textbook—you can learn Android even if you don’t know Java and even if you’re a pro-
gramming novice. This book includes a complete, 300-page introduction to the Java core
programming concepts that you’ll need when developing Android apps. The Java content
is appropriate for programming novices.

Android How to Program, 2/e was formed by merging 

• our professional book Android for Programmers: An App-Driven Approach, 2/e,
Volume 1 

• additional online chapters selected from Android for Programmers: An App-Driven
Approach, 2/e, Volume 2

• condensed, introductory core content on object-oriented Java programming
from our college textbook Java How to Program, 9/e 

• hundreds of Android short-answer questions and app-development exercises we
created for this book—most are in the book and many of the short-answer ques-
tions are in the test-item file for instructors.

We scoured the Android material, especially the fully coded Android apps, and enu-
merated the Java features that you’ll need to build these and similar apps. Then we
extracted the corresponding Java content from Java How to Program, 9/e. That’s a 1500-
page book, so it was challenging to whittle down that much content and keep it friendly,
even for programming novices.

When you study the Android content, you’ll be thinking like a developer from the
start. You’re going to study and build lots of real stuff and you’ll face the kinds of chal-
lenges professional developers must deal with. We’ll point you to the online documenta-

Preface
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tion and forums where you can find additional information and get answers to your
questions. We’ll also encourage you to read, modify and enhance open-source code as part
of your learning process.

Intended Audiences
There are several audiences for this book. Most commonly, it will be used in upper-level
elective college courses and industry professional courses for people familiar with object-
oriented programming but who may or may not know Java and want to learn Android app
development.

Uniquely, the book can also be used in introductory courses like CS1, intended for
programming novices. We recommend that schools typically offering many sections of
CS1 in Java consider designating one or two sections for ambitious students who have at
least some prior programming experience and who want to work hard to learn a good
amount of Java and Android in an aggressively paced one-semester course. The schools
may want to list the courses with “honors” or “accelerated” designations. The book works
especially well in two-semester introductory programming sequences where the introduc-
tion to Java is covered first.

App-Development Courses
In 2007, Stanford offered a new course called Creating Engaging Facebook Apps. Students
worked in teams developing apps, some of which landed in Facebook’s top 10, earning some
of the student developers millions of dollars.1 This course gained wide recognition for en-
couraging student creativity and teamwork. Scores of colleges now offer app-development
courses across many social networking and mobile platforms such as Android and iOS. We
encourage you to read the online mobile app development syllabi and check out the You-
Tube™ videos created by instructors and students for many of these courses. 

Android Ecosystem: Competition, Innovation, Explosive Growth 
and Opportunities
Sales of Android devices and app downloads have been growing exponentially. The first-
generation Android phones were released in October 2008. A study by Strategy Analytics
showed that by October 2013, Android had 81.3% of the global smartphone market
share, compared to 13.4% for Apple, 4.1% for Microsoft and 1% for Blackberry.2 Accord-
ing to an IDC report, by the end of the first quarter of 2013 Android had 56.5% of the
global tablet market share, compared to 39.6% for Apple’s iPad and 3.7% for Microsoft
Windows tablets.3 

There are now over one billion Android smartphones and tablets in use,4 and more
than 1.5 million Android devices are being activated daily.5 According to IDC, Samsung

1. http://www.businessinsider.com/these-stanford-students-made-millions-taking-a-
class-on-facebook-2011-5.

2. http://blogs.strategyanalytics.com/WSS/post/2013/10/31/Android-Captures-Record-
81-Percent-Share-of-Global-Smartphone-Shipments-in-Q3-2013.aspx.

3. http://www.idc.com/getdoc.jsp?containerId=prUS24093213.
4. http://www.android.com/kitkat.
5. http://www.technobuffalo.com/2013/04/16/google-daily-android-activations-1-5-million.
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is the leading Android manufacturer, accounting for nearly 40% of Android device ship-
ments in the third quarter of 2013. 

Billions of apps have been downloaded from Google Play™—Google’s marketplace
for Android Apps. The opportunities for Android app developers are enormous.

Fierce competition among popular mobile platforms and carriers is leading to rapid
innovation and falling prices. Competition among the dozens of Android device manufac-
turers is driving hardware and software innovation within the Android community. 

App-Driven Approach
At the heart of the book is our app-driven approach—we present concepts in the context
of seven complete working Android apps in the print book and more online. We begin each
of the app chapters with an introduction to the app, an app test-drive showing one or more
sample executions, and a technologies overview. We build the app’s GUI and resource files.
Then we proceed with a detailed code walkthrough of the app’s source code in which we
discuss the programming concepts and demonstrate the functionality of the Android APIs
used in the app. All the source code is available at the book’s Companion Website
www.pearsonglobaleditions.com/Deitel. We recommend that you have the source
code open in the IDE as you read the book. Figure 1 lists the book’s apps and the key tech-
nologies we used to build each. 

App Technologies

Chapter 2, Welcome App The Android Developer Tools (the Eclipse IDE 
and the ADT Plugin), visual GUI design, lay-
outs, TextViews, ImageViews, accessibility and 
internationalization.

Chapter 3, Tip Calculator App GridLayout, LinearLayout, EditText, SeekBar, 
event handling, NumberFormat and defining app 
functionality with Java.

Chapter 4, Twitter® Searches App SharedPreferences, collections, ImageButton, 
ListView, ListActivity, ArrayAdapter, implicit 
intents and AlertDialogs.

Chapter 5, Flag Quiz App Fragments, menus, preferences, AssetManager, 
tweened animations, Handler, Toasts, Explicit 
Intents, layouts for multiple device orientations.

Chapter 6, Cannon Game App Listening for touches, frame-by-frame anima-
tion, graphics, sound, threading, SurfaceView 
and SurfaceHolder.

Chapter 7, Doodlz App Two-dimensional graphics, Canvas, Bitmap, 
accelerometer, SensorManager, multitouch 
events, MediaStore, printing and Immersive 
Mode.

Chapter 8, Address Book App AdapterViews and Adapters

Fig. 1 | Android How to Program apps in the print book.
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Online Chapters and Book Updates
The Companion Website contains additional app-development chapters that introduce
property animation, Google Play game services, video, speech synthesis and recognition,
GPS, the Maps API, the compass, object serialization, Internet-enabled apps, audio re-
cording and playback, Bluetooth®, HTML5 mobile apps and more. Most of these chap-
ters will be available for fall 2014 courses. For the status of the online chapters and for
continuing book updates, visit 

Join the Deitel communities on Facebook® (http://www.deitel.com/deitelfan),
Twitter® (@deitel), LinkedIn® (http://bit.ly/DeitelLinkedIn) Google+™ (http://
google.com/+DeitelFan), and YouTube™ (http://youtube.com/user/DeitelTV) and
subscribe to the Deitel® Buzz Online newsletter (http://www.deitel.com/newsletter/
subscribe.html).

Copyright Notice and Code License
All of the Android code and Android apps in the book are copyrighted by Deitel & Associates,
Inc. The sample Android apps in the book are licensed under a Creative Commons Attribution
3.0 Unported License (http://creativecommons.org/licenses/by/3.0), with the excep-
tion that they may not be reused in any way in educational tutorials and textbooks, whether in
print or digital format. Additionally, the authors and publisher make no warranty of any kind,
expressed or implied, with regard to these programs or to the documentation contained in this
book. The authors and publisher shall not be liable in any event for incidental or consequential
damages in connection with, or arising out of, the furnishing, performance, or use of these pro-
grams. You’re welcome to use the apps in the book as shells for your own apps, building on their
existing functionality. If you have any questions, contact us at deitel@deitel.com.

Getting up to Speed in Java and XML
The Android portion of this book assumes that you already know Java and object-oriented
programming. If you’re not familiar with these, the appendices provide a condensed,
friendly introduction to Java and the object-oriented programming techniques you’ll need
to develop Android apps. If you’re interested in learning Java in more depth, you may want
to check out the comprehensive treatment in our textbook Java How to Program, 10/e
www.pearsonglobaleditions.com/Deitel.

Because of the improved Android development tools, we were able to eliminate
almost all XML markup in this edition. There are still two small, easy-to-understand XML
files you’ll need to manipulate. If you’re not familiar with XML, see these online tutorials:

• http://www.deitel.com/articles/xml_tutorials/20060401/XMLBasics/

• http://www.deitel.com/articles/xml_tutorials/20060401/

XMLStructuringData/

• http://www.ibm.com/developerworks/xml/newto/ 

• http://www.w3schools.com/xml/xml_whatis.asp 

www.pearsonglobaleditions.com/Deitel
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Key Features of Android How to Program, 2/e
• Android SDK 4.3 and 4.4. We cover various new Android Software Develop-

ment Kit (SDK) 4.3 and 4.4 features. [Note: The apps in this book are configured
to run on Android devices with Android 4.3 and higher; however, most apps will
work in 4.0 and higher by changing their minimum required SDK.]

• Fragments. Starting with Chapter 5, we use Fragments to create and manage por-
tions of each app’s GUI. You can combine several fragments to create user inter-
faces that take advantage of tablet screen sizes. You also can easily interchange
fragments to make your GUIs more dynamic, as you’ll do in Chapter 8. 

• Support for multiple screen sizes and resolutions. Throughout the app chapters
we demonstrate how to use Android’s mechanisms for automatically choosing re-
sources (layouts, images, etc.) based on a device’s size and orientation. 

• Eclipse-Based Android Development Tools (ADT) coverage in the print book.
The free Android Development Tools (ADT) integrated development environ-
ment (IDE)—which includes Eclipse and the ADT plugin—combined with the
free Java Development Kit (JDK) provide all the software you’ll need to create,
run and debug Android apps, export them for distribution (e.g., upload them to
Google Play™) and more.

• Android Studio. This is the preferred IDE for the future of Android app develop-
ment. Because this IDE is evolving quickly, we put our discussions of it online at:

• Immersive Mode. The status bar at the top of the screen and the menu buttons at
the bottom can be hidden, allowing your apps to fill more of the screen. Users
can access the status bar by swiping down from the top of the screen, and the sys-
tem bar (with the back button, home button and recent apps button) by swiping
up from the bottom.

• Printing Framework. Android 4.4 KitKat allows you to add printing functional-
ity to your apps, such as locating available printers over Wi-Fi or the cloud, se-
lecting the paper size and specifying which pages to print.

• Testing on Android Smartphones, Tablets and the Android Emulator. For the best
app-development experience, you should test your apps on actual Android smart-
phones and tablets. You can still have a meaningful experience using the Android
emulator (see the Before You Begin section), however it’s processor-intensive and
can be slow—particularly with games that have a lot of moving parts. In Chapter 1,
we mention some Android features that are not supported on the emulator.

• Multimedia. The apps in the print book use a broad range of Android multime-
dia capabilities, including graphics, images, frame-by-frame animation and au-
dio. The apps in the online chapters use property animation, video, speech
synthesis and speech recognition.

• Android Best Practices. We adhere to accepted Android best practices, pointing
them out in the detailed code walkthroughs. For more information, visit http://
developer.android.com/guide/practices/index.html. 

• Java Content in the Appendices Can Be Used With Java SE 6 or Higher.

    www.pearsonglobaleditions.com/Deitel
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• Java Exception Handling. We integrate basic exception handling early in the Java
content then present a richer treatment in Appendix H; we use exception han-
dling throughout the Android chapters.

• Classes Arrays and ArrayList; Collections. Appendix E covers class Arrays—
which contains methods for performing common array manipulations—and ge-
neric class ArrayList—which implements a dynamically resizable array-like data
structure. Appendix J introduces Java’s generic collections that are used frequent-
ly in our Android treatment. 

• Java Multithreading. Maintaining app responsiveness is a key to building robust
Android apps and requires extensive use of Android multithreading. Appendix J
introduces multithreading fundamentals so that you can understand our use of
the Android AsyncTask class in Chapter 8.

• GUI Presentation. Appendix I introduces Java GUI development. Android pro-
vides its own GUI components, so this appendix presents a few Java GUI com-
ponents and focuses on nested classes and anonymous inner classes, which are
used extensively for event-handling in Android GUIs.

Working with Open-Source Apps
There are numerous free, open-source Android apps available online which are excellent
resources for learning Android app development. We encourage you to download open-
source apps and read their source code to understand how they work. Throughout the
book you’ll find programming exercises that ask you to modify or enhance existing open-
source apps. Our goal is to give you handles on interesting problems that may also inspire
you to create new apps using the same technologies. Caution: The terms of open source
licenses vary considerably. Some allow you to use the app’s source code freely for any pur-
pose, while others stipulate that the code is available for personal use only—not for creat-
ing for-sale or publicly available apps. Be sure to read the licensing agreements carefully.
If you wish to create a commercial app based on an open-source app, you should con-
sider having an intellectual property attorney read the license; be aware that these attor-
neys charge significant fees.

Pedagogic Features
Syntax Shading. For readability, we syntax shade the code, similar to Eclipse’s and An-
droid Studio’s use of syntax coloring. Our syntax-shading conventions are as follows:

Code Highlighting. We emphasize the key code segments in each program by enclosing
them in light gray rectangles.

Using Fonts for Emphasis. We use various font conventions:

• The defining occurrences of key terms appear in bold for easy reference.

• On-screen IDE components appear in bold Helvetica (e.g., the File menu).

comments appear in gray
constants and literal values appear in bold darker gray
keywords appear in bold black
all other code appears in non-bold black
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• Program source code appears in Lucida (e.g., int x = 5;).

In this book you’ll create GUIs using a combination of visual programming (point
and click, drag and drop) and writing code. 

We use different fonts when we refer to GUI elements in program code versus GUI
elements displayed in the IDE:

• When we refer to a GUI component that we create in a program, we place its class
name and object name in a Lucida font—e.g., “Button saveContactButton.”

• When we refer to a GUI component that’s part of the IDE, we place the compo-
nent’s text in a bold Helvetica font and use a plain text font for the component’s
type—e.g., “the File menu” or “the Run button.”

Using the > Character. We use the > character to indicate selecting a menu item from a
menu. For example, we use the notation File > New to indicate that you should select the
New menu item from the File menu. 

Source Code. All of the book’s source code is available for download from: 

Chapter Objectives. Each chapter begins with a list of learning objectives. 

Figures. Hundreds of tables, source code listings and screen shots are included.

Software Engineering. We stress program clarity and performance, and concentrate on
building well-engineered, object-oriented software.

Self-Review Exercises and Answers. Extensive self-review exercises and answers are includ-
ed for self study. 

Exercises with a Current Flair. We’ve worked hard to create topical Android app-develop-
ment exercises. You’ll develop apps using a broad array of current technologies. All of the
Android programming exercises require the implementation of complete apps. You’ll be
asked to enhance the existing chapter apps, develop similar apps, use your creativity to de-
velop your own apps that use the chapter technologies and build new apps based on open-
source apps available on the Internet (and again, be sure to read and comply with the
open-source code-license terms for each app). The Android exercises also include short-
answer fill-in and true/false questions.

In the Java exercises, you’ll be asked to recall important terms and concepts; indicate
what code segments do; indicate what’s wrong with a portion of code; write Java state-
ments, methods and classes; and write complete Java programs.

Index. We include an extensive index for reference. The page number of the defining oc-
currence of each key term in the book is highlighted in the index in bold.

Software Used in Android How to Program, 2/e
All the software you’ll need for this book is available free for download from the Internet.
See the Before You Begin section for the download links. 

www.pearsonglobaleditions.com/Deitel
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Documentation. All the Android and Java documentation you’ll need to develop Android
apps is available free at http://developer.android.com and http://www.oracle.com/
technetwork/java/javase/downloads/index.html. The documentation for Eclipse is
available at www.eclipse.org/documentation. The documentation for Android Studio is
available at http://developer.android.com/sdk/installing/studio.html.

Instructor Resources
The following supplements are available to qualified college instructors only through Pear-
son Education’s Instructor Resource Center www.pearsonglobaleditions.com/Deitel:

• PowerPoint® slides containing all the code and figures in the text. 

• Test Item File of short-answer questions.

• Solutions Manual with solutions to the end-of-chapter short-answer exercises
for both the Java and Android content. For the Java content, solutions are pro-
vided for most of the programming exercises. 
   The suggested Android app-development project exercises are not typical
homework problems. These tend to be substantial projects—many of which
could require weeks of effort, possibly with students working in teams. Selected
solutions only are provided for these project exercises—these will be available on
the Pearson Instructor’s Resource Center (IRC) for fall semester 2014 classes.
Contact us at deitel@deitel.com if you have any questions. 

Please do not write to us requesting access to the Pearson Instructor’s Resource Center.
Access is restricted to qualified college instructors teaching from the book. Instructors may
obtain access only through their Pearson representatives. If you’re not a registered faculty
member, contact your Pearson representative.

Before You Begin
For information configuring your computer so that you can develop apps with Java and
Android, see the Before You Begin section that follows this Preface.
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(Consultant), William E. Duncan (Louisiana State University), Diana Franklin (Univer-
sity of California, Santa Barbara), Edward F. Gehringer (North Carolina State Universi-
ty), Huiwei Guan (Northshore Community College), Ric Heishman (George Mason
University), Dr. Heinz Kabutz (JavaSpecialists.eu), Patty Kraft (San Diego State Univer-
sity), Lawrence Premkumar (Sun Microsystems), Tim Margush (University of Akron),
Sue McFarland Metzger (Villanova University), Shyamal Mitra (The University of Texas
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gia Tech), Vinod Varma (Astra Infotech Private Limited) and Alexander Zuev (Sun
Microsystems).

As you read the book, we’d sincerely appreciate your comments, criticisms and sug-
gestions for improving the text. Please address all correspondence to:

We’ll respond promptly. We really enjoyed writing this book—we hope you enjoy reading it! 

Paul Deitel
Harvey Deitel
Abbey Deitel

deitel@deitel.com
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To learn more about Deitel’s Dive-Into® Series Corporate Training curriculum, visit:

To request a proposal for worldwide on-site, instructor-led training at your organization,
e-mail deitel@deitel.com.

Individuals wishing to purchase Deitel books and LiveLessons video training can do so
through www.deitel.com. Bulk orders by corporations, the government, the military and
academic institutions should be placed directly with Pearson. For more information,
please contact your Pearson representative.

Pearson wishes to thank and acknowledge the following people for their work on the
Global Edition:

Contributor:
Muthuraj M., Android Developer

Reviewers:
SC Raghavendra SSE, Intuit, India
Manasa S., NMAM Institute of Technology, Nitte, India

http://www.deitel.com/training
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In this section, you’ll set up your computer for use with this book. The Android develop-
ment tools are frequently updated. Before reading this section, check the book’s website

to see if we’ve posted an updated version.

Font and Naming Conventions
We use fonts to distinguish between on-screen components (such as menu names and
menu items) and Java code or commands. Our convention is to show on-screen compo-
nents in a sans-serif bold Helvetica font (for example, Project menu) and to show file
names, Java code and commands in a sans-serif Lucida font (for example, the keyword
public or class Activity). When specifying commands to select in menus, we use the >
notation to indicate a menu item to select. For example, Window > Preferences indicates
that you should select the Preferences menu item from the Window menu.

Software and Hardware System Requirements
To develop Android apps you need a Windows®, Linux or Mac OS X system. To view the
latest operating-system requirements visit:

and scroll down to the SYSTEM REQUIREMENTS heading. We developed the apps in this
book using the following software:

• Java SE 7 Software Development Kit

• Android SDK/ADT Bundle based on the Eclipse IDE

• Android SDK versions 4.3 and 4.4

You’ll see how to obtain each of these in the next sections. 

Installing the Java Development Kit (JDK)
Android requires the Java Development Kit (JDK) version 7 (JDK 7) or 6 (JDK 6). We used
JDK 7. To download the JDK for Windows, OS X or Linux, go to

You need only the JDK. Choose the 32-bit or 64-bit version based on your computer
hardware and operating system. Most recent computers have 64-bit hardware—check
your system’s specifications. If you have a 32-bit operating system, you must use the 32-
bit JDK. Be sure to follow the installation instructions at

www.pearsonglobaleditions.com/Deitel

http://developer.android.com/sdk/index.html

http://www.oracle.com/technetwork/java/javase/downloads/index.html

http://docs.oracle.com/javase/7/docs/webnotes/install/index.html

Before You 
Begin
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Android Integrated Development Environment (IDE) Options
Google now provides two Android IDE options:

• Android SDK/ADT bundle—a version of the Eclipse IDE that comes preconfig-
ured with the latest Android Software Development Kit (SDK) and the latest An-
droid Development Tools (ADT) plugin. At the time of this writing, these were
Android SDK version 4.4 and ADT version 22.3.

• Android Studio—Google’s new Android IDE based on IntelliJ® IDEA and their
preferred future IDE.

The Android SDK/ADT bundle has been widely used in Android app development for
several years. Android Studio, introduced in May 2013, is an early access version and will
be evolving rapidly. For this reason, we’ll stay with the widely used Android SDK/ADT
bundle in the book, and as online supplements at 

we’ll provide Android Studio versions of the Chapter 1 Test-Drive section and the Build-
ing the GUI section for each app, as appropriate.

Installing the Android SDK/ADT Bundle 
To download the Android SDK/ADT bundle, go to

and click the Download the SDK ADT Bundle button. When the download completes, extract
the ZIP file’s contents to your system. The resulting folder has an eclipse subfolder con-
taining the Eclipse IDE and an sdk subfolder containing the Android SDK. As with the
JDK, you can choose a 32-bit or 64-bit version. The Android SDK/ADT bundle 32-bit ver-
sion should be used with the 32-bit JDK, and the 64-bit version with the 64-bit JDK. 

Installing Android Studio
The IDE instructions in the printed book use the Android SDK/ADT bundle. You can
also optionally install and use Android Studio. To download Android Studio, go to

and click the Download Android Studio button. When the download completes, run the in-
staller and follow the on-screen instructions to complete the installation. [Note: For Android
4.4 development in Android Studio, Android now supports Java SE 7 language features, in-
cluding the diamond operator, multi-catch, Strings in switch and try-with-resources.]

Set the Java Compiler Compliance Level and Show Line Numbers
Android does not fully support Java SE 7. To ensure that the book’s examples compile cor-
rectly, configure Eclipse to produce files that are compatible with Java SE 6 by performing
the following steps:

1. Open Eclipse (  or ), which is located in the eclipse subfolder of the An-
droid SDK/ADT bundle’s installation folder. 

2. When the Workspace Launcher window appears, click OK. 

www.pearsonglobaleditions.com/Deitel 

http://developer.android.com/sdk/index.html

http://developer.android.com/sdk/installing/studio.html
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3. Select Window > Preferences to display the Preferences window. On Mac OS X,
select ADT > Preferences….

4. Expand the Java node and select the Compiler node. Under JDK Compliance, set
the Compiler compliance level to 1.6 (to indicate that Eclipse should produce
compiled code that’s compatible with Java SE 6).

5. Expand the General > Editors node and select TextEditors, then ensure that Show
line numbers is selected and click OK.

6. Close Eclipse.

Android 4.3 SDK
This book’s examples were written using the Android 4.3 and 4.4 SDKs. At the time of
this writing, 4.4 was the version included with the Android SDK/ADT bundle and An-
droid Studio. You should also install Android 4.3 (and any other versions you might want
to support in your apps). To install other Android platform versions, perform the follow-
ing steps (skipping Steps 1 and 2 if Eclipse is already open):

1. Open Eclipse. Depending on your platform, the icon will appear as  or . 

2. When the Workspace Launcher window appears, click OK. 

3. On Mac OS X, if you see a window indicating “Could not find SDK folder '/Users/
YourAccount/android-sdk-macosx/',” click Open Preferences then Browse… and
select the sdk folder located where you extracted the Android SDK/ADT bundle.

4. Select Window > Android SDK Manager to display the Android SDK Manager (Fig. 1).

5. The Android SDK Manager’s Name column shows all of the tools, platform versions
and extras (such as APIs for interacting with Google services, like Maps) that you

Fig. 1 | Android SDK Manager window.
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can install. Uncheck the Installed checkbox. Then, if any of Tools, Android 4.4
(API19), Android 4.3 (API18) and Extras appear in the Packages list, ensure that
they’re checked and click Install # packages… (# is the number of items to be in-
stalled) to display the Choose Packages to Install window. Most items in the Extras
node are optional. For this book, you’ll need the Android Support Library and
Google Play services. The Google USB Driver is necessary for Windows users who
wish to test apps on Android devices.]  

6. In the Choose Packages to Install window, read the license agreements for each
item. When you’re done, click the Accept License radio button, then click the In-
stall button. The status of the installation process will be displayed in the Android
SDK Manager window. 

Creating Android Virtual Devices (AVDs) 
The Android emulator, included in the Android SDK, allows you to test apps on your com-
puter rather than on an actual Android device. This is useful if you’re learning Android and
don’t have access to Android devices, but can be very slow, so a real device is preferred if you
have one. There are some hardware acceleration features that can improve emulator perfor-
mance (developer.android.com/tools/devices/emulator.html#acceleration). Before
running an app in the emulator, you must create an Android Virtual Device (AVD) which
defines the characteristics of the device you want to test on, including the screen size in pixels,
the pixel density, the physical size of the screen, size of the SD card for data storage and more.
To test your apps for multiple Android devices, you can create AVDs that emulate each
unique device. For this book, we use AVDs for Google’s Android reference devices—the
Nexus 4 phone, the Nexus 7 small tablet and Nexus 10 large tablet—which run unmodified
versions of Android. To do so, perform the following steps:

1. Open Eclipse.

2. Select Window > Android Virtual Device Manager to display the Android Virtual De-
vice Manager window, then select the Device Definitions tab (Fig. 2).

Fig. 2 | Android Virtual Device Manager window.
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3. Google provides preconfigured devices that you can use to create AVDs. Select
Nexus 4 by Google, then click Create AVD… to display the Create new Android Vir-
tual Device (AVD) window (Fig. 3), then configure the options as shown and click
OK to create the AVD. If you check Hardware keyboard present, you’ll be able to
use your computer’s keyboard to type data into apps that are running in the
AVD, but this may prevent the soft keyboard from displaying on the screen. If
your computer does not have a camera, you can select Emulated for the Front
Camera and Back Camera options. Each AVD you create has many other options
specified in its config.ini. You can modify this file as described at 

to more precisely match the hardware configuration of your device. 

4. We also configured Android 4.3 AVDs that represent Nexus 7 by Google and Nex-
us 10 by Google for testing our tablet apps. Their settings are shown in Fig. 4. In

   http://developer.android.com/tools/devices/managing-avds.html

Fig. 3 | Configuring a Nexus 4 smartphone AVD for Android 4.3.
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addition, we configured Android 4.4 AVDs for the Nexus 4, Nexus 7 and Nexus
10 with the names: AVD_for_Nexus_4_KitKat, AVD_for_Nexus_7_KitKat, and
AVD_for_Nexus_10_KitKat,   

(Optional) Setting Up an Android Device for Development
As we mentioned, testing apps on AVDs can be slow due to AVD performance. If you
have an Android device available to you, you should test the apps on that device. In addi-
tion, there are some features that you can test only on actual devices. To execute your apps
on Android devices, follow the instructions at 

If you’re developing on Microsoft Windows, you’ll also need the Windows USB driver for
Android devices. In some cases on Windows, you may also need device-specific USB driv-
ers. For a list of USB driver sites for various device brands, visit:

Fig. 4 | Configuring Nexus 7 and Nexus 10 tablet AVDs.

http://developer.android.com/tools/device.html

http://developer.android.com/tools/extras/oem-usb.html
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Obtaining the Book’s Code Examples
The examples for Android How to Program, 2/e are available for download at 

If you’re not already registered at our website, go to www.deitel.com and click the Register
link. Fill in your information. Registration is free, and we do not share your information 
with anyone. Please verify that you entered your registration e-mail address correctly—
you’ll receive a confirmation e-mail with your verification code. You must click the verifi-
cation link in the e-mail before you can sign in at www.deitel.com for the first time. Config-
ure your e-mail client to allow e-mails from deitel.com to ensure that the verification e-
mail is not filtered as junk mail. We send only occasional account-management e-mails
unless you register separately for our free Deitel® Buzz Online e-mail newsletter at 

Next, visit www.deitel.com and sign in using the Login link below our logo in the
upper-left corner of the page. Go to http://www.deitel.com/books/AndroidHTP2/.
Click the Examples link to download a ZIP archive file containing the examples to your
computer. Double click the ZIP file to unzip the archive, and make note of where you
extract the file’s contents on your system.

A Note Regarding the Android Development Tools
Google frequently updates the Android development tools. This often leads to problems
compiling our apps when, in fact, the apps do not contain any errors. If you import one
of our apps into Eclipse or Android Studio and it does not compile, there is probably a
minor configuration issue. Please contact us by e-mail at deitel@deitel.com or by post-
ing a question to:

• Facebook®—facebook.com/DeitelFan

• Google+™—google.com/+DeitelFan

and we’ll help you resolve the issue.

You’ve now installed all the software and downloaded the code examples you’ll need
to study Android app development with Android How to Program, 2/e and to begin devel-
oping your own apps. Enjoy! 

www.pearsonglobaleditions.com/Deitel

http://www.deitel.com/newsletter/subscribe.html
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1Introduction to Android

O b j e c t i v e s
In this chapter you’ll be 

introduced to:

■ The history of Android and 
the Android SDK.

■ Google Play Store for 
downloading apps.

■ The Android packages used 
in this book to help you 
create Android apps.

■ Basic object-technology 
concepts.

■ Key software for Android app 
development, including the 
Android SDK, the Java SDK, 
the Eclipse integrated 
development environment 
(IDE) and Android Studio.

■ Important Android 
documentation.

■ Test-driving an Android 
drawing app in Eclipse (in the 
print book) and in Android 
Studio (online).

■ Characteristics of great 
Android apps.
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40 Chapter 1 Introduction to Android

1.1 Introduction
Welcome to Android app development! We hope that working with Android How to Pro-
gram, 2/e will be an informative, challenging, entertaining and rewarding experience for you. 

This portion of the book is geared toward students with Java programming experience.
We use only complete working apps, so if you don’t know Java but have object-oriented
programming experience in another language, such as C#, Objective-C/Cocoa or C++
(with class libraries), you should be able to master the material quickly, learning Java and
Java-style object-oriented programming as you learn Android app development. If you do
not know Java, we also provide a friendly, rich introduction to it in the book’s appendices. 

App-Driven Approach
We use an app-driven approach—new features are discussed in the context of complete
working Android apps, with one app per chapter. For each app, we first describe it, then
have you test-drive it. Next, we briefly overview the key Eclipse IDE (integrated develop-
ment environment), Java and Android SDK (Software Development Kit) technologies we
use to implement the app. For apps that require it, we walk through designing the GUI
visually using Eclipse. Then we provide the complete source-code listing, using line num-
bers, syntax shading and code highlighting to emphasize the key portions of the code. We
also show one or more screen shots of the running app. Then we do a detailed code walk-
through, emphasizing the new programming concepts introduced in the app. You can
download the source code for all of the book’s apps from http://www.deitel.com/
books/AndroidHTP2/. 

1.1  Introduction 
1.2  Android—The World’s Leading 

Mobile Operating System 
1.3  Android Features 
1.4  Android Operating System 

1.4.1 Android 2.2 (Froyo)
1.4.2 Android 2.3 (Gingerbread)
1.4.3 Android 3.0 through 3.2 

(Honeycomb)
1.4.4 Android 4.0 through 4.0.4 (Ice Cream 

Sandwich)
1.4.5 Android 4.1–4.3 (Jelly Bean)
1.4.6 Android 4.4 (KitKat)

1.5  Downloading Apps from Google Play 
1.6  Packages 
1.7  Android Software Development Kit 

(SDK) 
1.8  Object-Oriented Programming: A 

Quick Refresher 

1.8.1 The Automobile as an Object
1.8.2 Methods and Classes
1.8.3 Instantiation
1.8.4 Reuse
1.8.5 Messages and Method Calls
1.8.6 Attributes and Instance Variables
1.8.7 Encapsulation
1.8.8 Inheritance
1.8.9 Object-Oriented Analysis and Design 

(OOAD)
1.9  Test-Driving the Doodlz App in an 

Android Virtual Device (AVD) 
1.9.1 Running the Doodlz App in the 

Nexus 4 Smartphone AVD
1.9.2 Running the Doodlz App in a Tablet 

AVD
1.9.3 Running the Doodlz App on an 

Android Device
1.10  Building Great Android Apps 
1.11  Android Development Resources 
1.12  Wrap-Up 

Self-Review Exercises | Answers to Self-Review Exercises | Exercises
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For each chapter, we also provide Android Studio IDE versions of any Eclipse-specific
instructions. Because Android Studio is an early access version and will be evolving rap-
idly, we provide the Android Studio instructions on the book’s website 

This will enable us to keep the instructions up to date.

1.2 Android—The World’s Leading Mobile Operating 
System
Android device sales are growing quickly, creating enormous opportunities for Android
app developers. 

• The first-generation Android phones were released in October 2008. By October
2013, a Strategy Analytics report showed that Android had 81.3% of the global
smartphone market share, compared to 13.4% for Apple, 4.1% for Microsoft and
1% for Blackberry.1

• According to an IDC report, by the end of the first quarter of 2013 Android had
56.5% of the global tablet market share, compared to 39.6% for Apple’s iPad and
3.7% for Microsoft Windows tablets.2 

• As of April 2013, more than 1.5 million Android devices (including smart-
phones, tablets, etc.) were being activated daily.3 

• At the time of this writing, there were over one billion activated Android devices.4

• Android devices now include smartphones, tablets, e-readers, robots, jet engines,
NASA satellites, game consoles, refrigerators, televisions, cameras, health-care de-
vices, smartwatches, automobile in-vehicle “infotainment” systems (for control-
ling the radio, GPS, phone calls, thermostat, etc.) and more.5 

1.3 Android Features

Openness and Open Source
One benefit of developing Android apps is the openness of the platform. The operating sys-
tem is open source and free. This allows you to view Android’s source code and see how its
features are implemented. You can also contribute to Android by reporting bugs (see http:/
/source.android.com/source/report-bugs.html) or by participating in the Open Source
Project discussion groups (http://source.android.com/community/index.html). Nu-
merous open-source Android apps from Google and others are available on the Internet

http://www.deitel.com/books/AndroidHTP2

1. http://blogs.strategyanalytics.com/WSS/post/2013/10/31/Android-Captures-Record-
81-Percent-Share-of-Global-Smartphone-Shipments-in-Q3-2013.aspx.

2. http://www.idc.com/getdoc.jsp?containerId=prUS24093213.
3. http://www.technobuffalo.com/2013/04/16/google-daily-android-activations-1-5-

million.
4. http://venturebeat.com/2013/09/03/android-hits-1b-activations-and-will-be-called-

kitkat-in-next-version.
5. http://www.businessweek.com/articles/2013-05-29/behind-the-internet-of-things-is-

android-and-its-everywhere.
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(Fig. 1.1). Figure 1.2 shows you where you can get the Android source code, learn about the
philosophy behind the open-source operating system and get licensing information.   

The openness of the platform spurs rapid innovation. Unlike Apple’s proprietary iOS,
which is available only on Apple devices, Android is available on devices from dozens of orig-

URL  Description

http://en.wikipedia.org/wiki/

List_of_open_source_Android

_applications 

Extensive list of open-source apps, organized by cate-
gory (e.g., games, communication, emulators, multime-
dia, security). 

http://developer.android.com/

tools/samples/index.html 

Google’s sample apps for the Android platform; 
includes over 60 apps and games such as Lunar Lander, 
Snake and Tic Tac Toe.

http://github.com/ GitHub allows you to share your apps and source code 
and contribute to others’ open-source projects.

http://sourceforge.net SourceForge also allows you to share apps and source 
code and contribute to others’ open-source projects.

http://f-droid.org/ Hundreds of free and open-source Android apps 
including the Adblock Plus advertisement blocker, 
aMetro public transportation navigation, AnySoftKey-
board (available in several languages), Apollo music 
player, Chinese Checkers game, DroidWeight weight 
tracker, Earth Live Wallpaper and more.

http://blog.interstellr.com/

post/39321551640/14-great-

android-apps-that-are-also-

open-source

Lists 14 open-source Android apps with links to the 
code.

http://www.openintents.org/

en/libraries

Provides nearly 100 open-source libraries that can be 
used to enhance app capabilities.

http://www.androidviews.net Customized GUI controls for enhancing your app’s 
appearance.

http://www.stackoverflow.com Stack Overflow is a question-and-answer website for 
programmers. Users can vote on each answer, and the 
best responses rise to the top. 

Fig. 1.1 | Open-source Android app and library resource sites.

 Title URL

Get Android Source Code http://source.android.com/source/downloading.html

Governance Philosophy http://source.android.com/about/philosophy.html

Licenses http://source.android.com/source/licenses.html

FAQs http://source.android.com/source/faqs.html

Fig. 1.2 | Resources and source code for the open-source Android operating system.
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inal equipment manufacturers (OEMs) and through numerous telecommunications carriers
worldwide. The intense competition among OEMs and carriers benefits customers.

Java
Android apps are developed with Java—one of the world’s most widely used programming
languages. Java was a logical choice for the Android platform, because it’s powerful, free,
open source and millions of developers already know it. Experienced Java programmers
can quickly dive into Android development, using Google’s Android APIs (Application
Programming Interfaces) and others available from third parties. 

Java is object oriented and has access to extensive class libraries that help you develop
powerful apps quickly. GUI programming in Java is event driven—in this book, you’ll
write apps that respond to various user-initiated events such as screen touches. In addition
to directly programming portions of your apps, you’ll also use the Eclipse and Android
Studio IDEs to conveniently drag and drop predefined objects such as buttons and text-
boxes into place on your screen, and label and resize them. Using these IDEs, you can
create, run, test and debug Android apps quickly and conveniently. 

Multi-touch Screen
Android smartphones wrap the functionality of a mobile phone, Internet client, MP3
player, gaming console, digital camera and more into a handheld device with full-color
multi-touch screens. With the touch of your fingers, you can navigate easily between using
your phone, running apps, playing music, web browsing and more. The screen can display
a keyboard for typing e-mails and text messages and entering data in apps (some Android
devices also have physical keyboards).

Gestures
The multi-touch screens allow you to control the device with gestures involving one touch
or multiple simultaneous touches (Fig. 1.3).

Gesture name  Physical action Used to

Touch Tap the screen once. Open an app, “press” a button or a menu item.

Double touch Tap the screen twice. Zoom in on pictures, Google Maps and web 
pages. Tap the screen twice again to zoom back 
out.

Long press Touch the screen and hold 
your finger in position.

Select items in a view—for example, checking 
an item in a list.

Swipe Touch the screen, then move
your finger in the swipe
direction and release.

Flip item-by-item through a series, such as 
photos. A swipe automatically stops at the next 
item.

Drag Touch and drag your finger 
across the screen.

Move objects or icons, or scroll through a web 
page or list.

Pinch zoom Pinch two fingers together, 
or spread them apart.

Zoom in and out on the screen (e.g., resizing 
text and pictures).

Fig. 1.3 | Some common android gestures.
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Built-in Apps
Android devices come with several default apps, which may vary, depending on the device,
the manufacturer or the mobile service carrier. These typically include Phone, People,
Email, Browser, Camera, Photos, Messaging, Calendar, Play Store, Calculator and more. 

Web Services
Web services are software components stored on one computer that can be accessed by an
app (or other software component) on another computer over the Internet. With web ser-
vices, you can create mashups, which enable you to rapidly develop apps by quickly combin-
ing complementary web services, often from different organizations and possibly other forms
of information feeds. For example, 100 Destinations (www.100destinations.co.uk) com-
bines the photos and tweets from Twitter with the mapping capabilities of Google Maps to
allow you to explore countries around the world through the photos of others.

Programmableweb (http://www.programmableweb.com/) provides a directory of
over 9,400 APIs and 7,000 mashups, plus how-to guides and sample code for creating
your own mashups. Figure 1.4 lists some popular web services. According to Programma-
bleweb, the three most widely used APIs for mashups are Google Maps, Twitter and You-
Tube.  

Web services source How it’s used

Google Maps Mapping services
Twitter Microblogging 
YouTube Video search 
Facebook Social networking 
Instagram Photo sharing
Foursquare Mobile check-in
LinkedIn Social networking for business
Groupon Social commerce
Netflix Movie rentals
eBay Internet auctions
Wikipedia Collaborative encyclopedia
PayPal Payments
Last.fm Internet radio 
Amazon eCommerce Shopping for books and lots of other products
Salesforce.com Customer Relationship Management (CRM)
Skype Internet telephony
Microsoft Bing Search
Flickr Photo sharing
Zillow Real-estate pricing 
Yahoo Search Search
WeatherBug Weather

Fig. 1.4 | Some popular web services (http://www.programmableweb.com/apis/
directory/1?sort=mashups).  
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1.4 Android Operating System
The Android operating system was developed by Android, Inc., which was acquired by
Google in 2005. In 2007, the Open Handset Alliance™—which now has 84 company
members (http://www.openhandsetalliance.com/oha_members.html)—was formed to
develop, maintain and evolve Android, driving innovation in mobile technology and im-
proving the user experience while reducing costs. 

Android Version Naming Convention
Each new version of Android is named after a dessert, going in alphabetical order
(Fig. 1.5).

1.4.1 Android 2.2 (Froyo)
Android 2.2 (also called Froyo, released in May 2010) introduced external storage, allow-
ing you to store apps on an external memory device rather than just in the Android device’s
internal memory. It also introduced the Android Cloud to Device Messaging (C2DM)
service. Cloud computing allows you to use software and data stored in the “cloud”—i.e.,
accessed on remote computers (or servers) via the Internet and available on demand—rath-
er than having it stored on your desktop, notebook computer or mobile device. Cloud
computing gives you the flexibility to increase or decrease computing resources to meet
your resource needs at any given time, making it more cost effective than purchasing ex-
pensive hardware to ensure that you have enough storage and processing power for occa-
sional peak levels. Android C2DM allows app developers to send data from their servers
to their apps installed on Android devices, even when the apps are not currently running.
The server notifies the apps to contact it directly to receive updated app or user data.6

C2DM is now deprecated in favor of Google Cloud Messaging.
For information about additional Android 2.2 features—OpenGL ES 2.0 graphics

capabilities, the media framework and more—visit http://developer.android.com/
about/versions/android-2.2-highlights.html.

Android version Name

Android 1.5 Cupcake

Android 1.6 Donut

Android 2.0–2.1 Eclair

Android 2.2 Froyo

Android 2.3 Gingerbread

Android 3.0–3.2 Honeycomb

Android 4.0 Ice Cream Sandwich

Android 4.1–4.3 Jelly Bean

Android 4.4 KitKat

Fig. 1.5 | Android version numbers and the corresponding names.

6. http://code.google.com/android/c2dm/.
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1.4.2 Android 2.3 (Gingerbread)
Android 2.3 (Gingerbread), released later in 2010, added more user refinements, such as
a redesigned keyboard, improved navigation capabilities, increased power efficiency and
more. It also added several developer features for communications (e.g., technologies that
make it easier to make and receive calls from within an app), multimedia (e.g., new audio
and graphics APIs) and gaming (e.g., improved performance and new sensors, such as a
gyroscope for better motion processing). 

One of the most significant new features in Android 2.3 was support for near-field
communication (NFC)—a short-range wireless connectivity standard that enables com-
munication between two devices within a few centimeters. NFC support and features vary
by Android device. NFC can be used for payments (for example, touching your NFC-
enabled Android device to a payment device on a soda machine), exchanging data such as
contacts and pictures, pairing devices and accessories and more.

For a more Android 2.3 developer features, see http://developer.android.com/
about/versions/android-2.3-highlights.html.

1.4.3 Android 3.0 through 3.2 (Honeycomb)
Android 3.0 (Honeycomb) included user-interface improvements specifically for large-
screen devices (e.g., tablets), such as a redesigned keyboard for more efficient typing, a vi-
sually appealing 3D user interface, easier navigation between screens within an app and
more. New Android 3.0 developer features included: 

• fragments, which describe portions of an app’s user interface and can be com-
bined into one screen or used across multiple screens

• a persistent Action Bar at the top of the screen providing users with options for
interacting with apps

• the ability to add large-screen layouts to existing apps designed for small screens
to optimize your app for use on different screen sizes

• a visually attractive and more functional user interface, known as “Holo” for its
holographic look and feel

• a new animation framework 

• improved graphics and multimedia capabilities

• ability to use multicore processor architectures for enhanced performance

• increased Bluetooth support (e.g., enabling an app to determine if there are any
connected devices such as headphones or a keyboard)

• and an animation framework for animating user-interface or graphics objects.

For a list of Android 3.0 user and developer features and platform technologies, go to
http://developer.android.com/about/versions/android-3.0-highlights.html.

1.4.4 Android 4.0 through 4.0.4 (Ice Cream Sandwich)
Android 4.0 (Ice Cream Sandwich), released in 2011, merged Android 2.3 (Gingerbread)
and Android 3.0 (Honeycomb) into one operating system for use on all Android devices.
This allowed you to incorporate into your smartphone apps Honeycomb’s features that
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previously were available only on tablets—the “Holo” user interface, a new launcher (used
to customize the device’s home screen and launch apps) and more—and easily scale your
apps to work on different devices. Ice Cream Sandwich also added several APIs for im-
proved communication between devices, accessibility for users with disabilities (e.g., vision
impairments), social networking and more (Fig. 1.6). For a complete list of Android 4.0
APIs, see http://developer.android.com/about/versions/android-4.0.html. 

1.4.5 Android 4.1–4.3 (Jelly Bean)
Android Jelly Bean, released in 2012, includes support for external displays, improved se-
curity, appearance enhancements (e.g., resizable app widgets and larger app notifications)
and performance improvements that make switching between apps and screens more
seamless (Fig. 1.7). For the Jelly Bean features list, see http://developer.android.com/
about/versions/jelly-bean.html. 

Feature Description

Face detection Using the camera, compatible devices can determine the posi-
tioning of the user’s eyes, nose and mouth. The camera can also 
track the user’s eye movement, allowing you to create apps that 
change perspective, based on where the user is looking. 

Virtual camera operator When filming video of multiple people, the camera will auto-
matically focus on the person who is speaking. 

Android Beam Using NFC, Android Beam allows you to touch two Android 
devices to share content (e.g., contacts, pictures, videos). 

Wi-Fi Direct Wi-Fi P2P (peer-to-peer) APIs allow you to connect multiple 
Android devices using Wi-Fi. The devices can communicate 
wirelessly at a greater distance than when using Bluetooth.

Social API Access and share contact information across social networks and 
apps (with the user’s permission).

Calendar API Add and share events across multiple apps, manage alerts and 
attendees and more. 

Accessibility APIs Use the new Accessibility Text-to-Speech APIs to enhance the 
user experience of your apps for people with disabilities such as 
vision impairments and more. The explore-by-touch mode 
allows users with vision impairments to touch anywhere on the 
screen and hear a voice description of the touched content. 

Android@Home frame-
work

Use the Android@Home framework to create apps that control 
appliances in users’ homes, such as, thermostats, irrigation sys-
tems, networked light bulbs and more. 

Bluetooth Health 
Devices

Create apps that communicate with Bluetooth health devices 
such as scales, heart-rate monitors and more.

Fig. 1.6 | Some Android Ice Cream Sandwich developer features 
(http://developer.android.com/about/versions/android-4.0.html).
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1.4.6 Android 4.4 (KitKat)
Android 4.4 KitKat, released in October 2013, includes several performance improvements
that make it possible to run the operating system on all Android devices, including older,
memory-constrained devices, which are particularly popular in developing countries.7 

Enabling more users to update to KitKat will reduce the “fragmentation” of Android
versions in the market, which has been a challenge for developers who previously had to
design apps to run across multiple versions of the operating system, or limit their potential
market by targeting their apps to a specific version of the operating system.

Android KitKat also includes security and accessibility enhancements, improved
graphics and multimedia capabilities, memory-use analysis tools and more. Figure 1.8 lists
some of the key new KitKat features. For a complete list, see  

Feature Description

Android Beam You can use Android Beam to easily pair your smartphone or tablet with wire-
less Bluetooth® speakers or special headphones.

Lock screen widgets Create widgets that appear on the user’s screen when the device is locked, or 
modify your existing home-screen widgets so that they’re also visible when the 
device is locked.

Photo Sphere APIs for working with the new panoramic photo features that enable users to 
take 360-degree photos, similar to those used for Google Maps Street View.

Daydreams Daydreams are interactive screensavers that are activated when a device is 
docked or charging. Daydreams can play audio and video and respond to user 
interactions. 

Language support New features help your apps reach international users, such as bidirectional 
text (left-to-right or right-to-left), international keyboards, additional key-
board layouts and more.

Developer options Several new tracking and debugging features help you improve your apps, 
such as bug reports that include a screen shot and device state information.

Fig. 1.7 | Some Android Jelly Bean features (http://developer.android.com/about/
versions/jelly-bean.html).

7. http://techcrunch.com/2013/10/31/android-4-4-kitkat-google/.

http://developer.android.com/about/versions/kitkat.html

Feature Description

Immersive mode The status bar at the top of the screen and the menu buttons at the 
bottom can be hidden, allowing your apps to fill more of the screen. 
Users can access the status bar by swiping down from the top of the 
screen, and the system bar (with the back button, home button and 
recent apps button) by swiping up from the bottom.

Fig. 1.8 | Some Android KitKat features (http://developer.android.com/about/
versions/kitkat.html). (Part 1 of 2.)

M01_DEIT3397_02_SE_C01.fm  Page 48  Monday, July 7, 2014  8:53 AM



1.5  Downloading Apps from Google Play 49

1.5 Downloading Apps from Google Play
At the time of this writing, there were over one million apps in Google Play, and the number
is growing quickly.8 Figure 1.9 lists some popular free and fee-based apps. You can download
apps through the Play Store app installed on the device. You can also log into your Google
Play account at http://play.google.com through your web browser, then specify the An-
droid device on which to install the app. It will then download via the device’s WiFi or 3G/
4G connection. In Chapter 9, Google Play and App Business Issues, we discuss additional
app stores, offering your apps for free or charging a fee, app pricing and more. 

Printing framework Build printing functionality into your apps, including locating 
available printers over Wi-Fi or the cloud, selecting the paper size 
and specifying which pages to print.

Storage access framework Create document storage providers that allow users to browse, cre-
ate and edit files (e.g., documents and images) across multiple 
apps.

SMS provider Create SMS (Short Message Service) or MMS (Multimedia Mes-
saging Service) apps using the new SMS provider and APIs. Users 
can now select their default messaging app.

Transitions framework The new framework makes it easier to create transition anima-
tions.

Screen recording Record video of your app in action to create tutorials and market-
ing materials.

Enhanced accessibility The captioning manager API allows apps to check the user's cap-
tioning preferences (e.g., language, text styles and more). 

Chromium WebView Supports the latest standards for displaying web content including 
HTML5, CSS3 and a faster version of JavaScript.

Step detector and step 
counter

Create apps that detect whether the user is running, walking or 
climbing stairs and count the number of steps. 

Host Card Emulator 
(HCE)

HCE enables any app to perform secure NFC transactions (e.g., 
mobile payments) without the need for a secure element on the 
SIM card controlled by the wireless carrier. 

8. en.wikipedia.org/wiki/Google_Play.

Google Play category Some popular apps in the category

Books and Reference Kindle, Wikipedia, Audible for Android, Google Play Books

Business Office Suite Pro 7, Job Search, Square Register, GoToMeeting

Fig. 1.9 | Some popular Android apps in Google Play. (Part 1 of 2.)

Feature Description

Fig. 1.8 | Some Android KitKat features (http://developer.android.com/about/
versions/kitkat.html). (Part 2 of 2.)
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1.6 Packages
Android uses a collection of packages, which are named groups of related, predefined classes.
Some of the packages are Android specific, some are Java specific and some are Google spe-
cific. These packages allow you to conveniently access Android OS features and incorporate
them into your apps. The Android packages help you create apps that adhere to Android’s
unique look-and-feel conventions and style guidelines (http://developer.android.com/
design/index.html). Figure 1.10 lists the packages we discuss in this book. For a complete
list of Android packages, see developer.android.com/reference/packages.html.

Comics ComicRack, Memedroid Pro, Marvel Comics, Comic Strips

Communication Facebook Messenger, Skype™, GrooVe IP

Education Duolingo: Learn Languages Free, TED, Mobile Observatory

Entertainment SketchBook Mobile, Netflix, Fandango® Movies, iFunny :)

Finance Mint.com Personal Finance, Google Wallet, PayPal

Games: Arcade & Action Minecraft—Pocket Edition, Fruit Ninja, Angry Birds

Games: Brain & Puzzle Where’s My Water?, Draw Something, Can You Escape

Games: Cards & Casino Solitaire, Slots Delux, UNO™ & Friends, DH Texas Poker

Games: Casual Candy Crush Saga, Hardest Game Ever 2, Game Dev Story

Health & Fitness RunKeeper, Calorie Counter, Workout Trainer, WebMD®

Lifestyle Zillow Real Estate, Epicurious Recipe App, Family Locator

Live Wallpaper PicsArt, GO Launcher EX, Beautiful Widgets Pro

Media & Video MX Player, YouTube, KeepSafe Vault, RealPlayer®

Medical Epocrates, ICE: In Case of Emergency, Medscape®

Music & Audio Pandora®, Shazam, Spotify, Ultimate Guitar Tabs & Chords

News & Magazines Flipboard, Pulse News, CNN, Engadget, Drippler

Personalization Beautiful Widgets Pro, Zedge™, GO Launcher EX

Photography Camera ZOOM FX, Photo Grid, InstaPicFrame for Instagram

Productivity Adobe® Reader®, Dropbox, Google Keep, SwiftKey Keyboard

Shopping eBay, Amazon Mobile, Groupon, The Coupons App

Social Facebook®, Instagram, Vine, Twitter, Snapchat, Pinterest 

Sports SportsCenter for Android, NFL ’13, Team Stream™

Tools Titanium Backup PRO, Google Translate, Tiny Flashlight®

Transportation Uber, Trapster, Lyft, Hailo™, Ulysse Speedometer

Travel & Local Waze, GasBuddy, KAYAK, TripAdvisor, OpenTable®

Weather WeatherBug, AccuWeather, The Weather Channel

Widgets Zillow, DailyHoroscope, Starbucks, Family Locator

Google Play category Some popular apps in the category

Fig. 1.9 | Some popular Android apps in Google Play. (Part 2 of 2.)
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1.7 Android Software Development Kit (SDK)
The Android SDK provides the tools you’ll need to build Android apps. It’s available at
no charge through the Android Developers’ site. See the Before You Begin section for de-
tails on downloading the Android app-development tools you’ll need to develop Android
apps, including the Java SE, the Android SDK/ADT Bundle (which includes the Eclipse
IDE) and the Android Studio IDE. 

Package Description

android.app Includes high-level classes in the Android app model. (Chapter 3’s Tip 
Calculator app.)

android.content Access and publish data on a device. (Chapter 6’s Cannon Game app.)
android.content.res Classes for accessing app resources (e.g., media, colors, drawables, etc.), 

and device-configuration information affecting app behavior. 
(Chapter 5’s Flag Quiz app.)

android.database Handling data returned by the content provider. (Chapter 8’s Address 
Book app.)

android.database.sqlite SQLite database management for private databases. (Chapter 8’s 
Address Book app.)

android.graphics Graphics tools used for drawing to the screen. (Chapter 5’s Flag Quiz 
app and Chapter 7’s Doodlz app.)

android.hardware Device hardware support. (Chapter 7’s Doodlz app.)
android.media Classes for handling audio and video media interfaces. (Chapter 6’s 

Cannon Game app.)
android.net Network access classes. (Chapter 4’s Twitter® Searches app.)
android.os Operating-systems services. (Chapter 3’s Tip Calculator app.)
android.preference Working with an app’s user preferences. (Chapter 5’s Flag Quiz app.)
android.provider Access to Android content providers. (Chapter 7’s Doodlz app.)
android.support.

   v4.print 
Android Support Library features for using the Android 4.4 printing 
framework. (Chapter 7’s Doodlz app.)

android.text Rendering and tracking text on a device. (Chapter 3’s Tip Calculator app.)
android.util Utility methods and XML utilities. (Chapter 6’s Cannon Game app.)
android.widget User-interface classes for widgets. (Chapter 3’s Tip Calculator app.)
android.view User interface classes for layout and user interactions. (Chapter 4’s Twit-

ter® Searches app.)
java.io Streaming, serialization and file-system access of input and output facil-

ities. (Chapter 5’s Flag Quiz app.)
java.text Text formatting classes. (Chapter 4’s Twitter® Searches app.)
java.util Utility classes. (Chapter 4’s Twitter® Searches app.)
android.graphics.

  drawable      
Classes for display-only elements (e.g., gradients, etc.). (Chapter 5’s 
Flag Quiz app.)

Fig. 1.10 | Android and Java packages used in this book, listed with the chapter in which they 
first appear. 
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Android SDK/ADT Bundle
The Android SDK/ADT Bundle—which includes the Eclipse IDE—is the most widely
integrated development environment for Android development. Some developers use only
a text editor and command-line tools to create Android apps. The Eclipse IDE includes:

• Code editor with support for syntax coloring and line numbering

• Auto-indenting and auto-complete (i.e., type hinting)

• Debugger 

• Version control system

• Refactoring support

You’ll use Eclipse in Section 1.9 to test-drive the Doodlz app. Starting in Chapter 2, Wel-
come App, you’ll use Eclipse to build apps. 

Android Studio
Android Studio, a new Android IDE based on the JetBrains IntelliJ IDEA Java IDE
(http://www.jetbrains.com/idea/), was announced in 2013 and is Google’s preferred
Android IDE of the future. At the time of this writing, Android Studio was available only
as an early access preview—many of its features were still under development. For each
chapter, we also provide Android Studio versions of any Eclipse-specific instructions on
the book’s website 

To learn more about Android Studio, installing it and migrating from Eclipse, visit http:/
/developer.android.com/sdk/installing/studio.html. 

Android Development Tools (ADT) Plugin for Eclipse
The Android Development Tools (ADT) Plugin for Eclipse (part of the Android SDK/
ADT Bundle) allows you to create, run and debug Android apps, export them for distri-
bution (e.g., upload them to Google Play), and more. ADT also includes a visual GUI de-
sign tool. GUI components can be dragged and dropped into place to form GUIs without
any coding. You’ll learn more about ADT in Chapter 2.

The Android Emulator
The Android emulator, included in the Android SDK, allows you to run Android apps in a
simulated environment within Windows, Mac OS X or Linux, without using an actual An-
droid device. The emulator displays a realistic Android user-interface window. It’s particu-
larly useful if you do not have access to Android devices for testing. You should certainly test
your apps on a variety of Android devices before uploading them to Google Play.

Before running an app in the emulator, you’ll need to create an Android Virtual
Device (AVD), which defines the characteristics of the device on which you want to test,
including the hardware, system image, screen size, data storage and more. If you want to
test your apps for multiple Android devices, you’ll need to create separate AVDs to emu-
late each unique device, or use a service (like testdroid.com or appthwack.com) that
enables you to test on many different devices. 

We used the emulator (not an actual Android device) to take most but not all of the
Android screen shots for this book. You can reproduce on the emulator most of the

http://www.deitel.com/books/AndroidHTP2
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Android gestures (Fig. 1.11) and controls (Fig. 1.12) using your computer’s keyboard and
mouse. The gestures on the emulator are a bit limited, since your computer probably
cannot simulate all the Android hardware features. For example, to test GPS apps in the
emulator, you’ll need to create files that simulate GPS readings. Also, although you can
simulate orientation changes (to portrait or landscape mode), simulating particular accel-
erometer readings (the accelerometer allows the device to respond to up/down, left/right
and forward/backward acceleration) requires features that are not built into the emulator.
There is a Sensor Simulator available at

that you can use to send simulated sensor information into an AVD to test other sensor
features in your apps. Figure 1.13 lists Android functionality that’s not available on the
emulator. You can, however, upload your app to an Android device to test these features.
You’ll start creating AVDs and using the emulator to develop Android apps in Chapter 2’s
Welcome app.    

https://code.google.com/p/openintents/wiki/SensorSimulator

Gesture Emulator action

Touch Click the mouse once. Introduced in Chapter 3’s Tip Calculator app.

Double touch Double click the mouse. Introduced in Chapter 6’s Cannon Game app.

Long press Click and hold the mouse.

Drag Click, hold and drag the mouse. Introduced in Chapter 6’s Cannon 
Game app.

Swipe Click and hold the mouse, move the pointer in the swipe direction and 
release the mouse. Introduced in Chapter 8’s Address Book app.

Pinch zoom Press and hold the Ctrl (Control) key. Two circles that simulate the two 
touches will appear. Move the circles to the start position, click and 
hold the mouse and drag the circles to the end position. 

Fig. 1.11 | Android gestures on the emulator.  

Control Emulator action

Back Esc

Call/dial button F3

Camera Ctrl-KEYPAD_5, Ctrl-F3

End call button F4

Home Home button

Menu (left softkey) F2 or Page Up button

Power button F7

Fig. 1.12 | Android hardware controls on the emulator (for additional controls, 
go to http://developer.android.com/tools/help/emulator.html). (Part 1 of 2.) 
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1.8 Object-Oriented Programming: A Quick Refresher
Android uses object-oriented programming techniques, so in this section we review the ba-
sics of object technology. We use all of these concepts in this book.

Building software quickly, correctly and economically remains an elusive goal at a
time when demands for new and more powerful software are soaring. Objects, or more pre-
cisely the classes objects come from, are essentially reusable software components. There are
date objects, time objects, audio objects, video objects, automobile objects, people objects,
etc. Almost any noun can be reasonably represented as a software object in terms of attri-
butes (e.g., name, color and size) and behaviors (e.g., calculating, moving and communi-
cating). Software developers are discovering that using a modular, object-oriented design-
and-implementation approach can make software development groups much more pro-
ductive than they could be with earlier popular techniques like “structured program-
ming”—object-oriented programs are often easier to understand, correct and modify.

Search F5

* (right softkey) Shift-F2 or Page Down button

Rotate to previous orientation KEYPAD_7, Ctrl-F11

Rotate to next orientation KEYPAD_9, Ctrl-F12

Toggle cell networking on/off F8

Volume up button KEYPAD_PLUS, Ctrl-F5

Volume down button KEYPAD_MINUS, Ctrl-F6

Android functionality not available on the emulator

• Making or receiving real phone calls (the emulator allows simulated calls only)

• Bluetooth

• USB connections

• Device-attached headphones

• Determining connected state of the phone

• Determining battery charge or power charging state

• Determining SD card insert/eject

• Sensors (accelerometer, barometer, compass, light sensor, proximity sensor)

Fig. 1.13 | Android functionality not available on the emulator 
(http://developer.android.com/tools/devices/emulator.html).

Control Emulator action

Fig. 1.12 | Android hardware controls on the emulator (for additional controls, 
go to http://developer.android.com/tools/help/emulator.html). (Part 2 of 2.) 
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1.8.1 The Automobile as an Object
To help you understand objects and their contents, let’s begin with a simple analogy. Sup-
pose you want to drive a car and make it go faster by pressing its accelerator pedal. What must
happen before you can do this? Well, before you can drive a car, someone has to design it.
A car typically begins as engineering drawings, similar to the blueprints that describe the
design of a house. These drawings include the design for an accelerator pedal. The pedal
hides from the driver the complex mechanisms that actually make the car go faster, just as
the brake pedal hides the mechanisms that slow the car, and the steering wheel hides the
mechanisms that turn the car. This enables people with little or no knowledge of how en-
gines, braking and steering mechanisms work to drive a car easily.

Just as you cannot cook meals in the kitchen of a blueprint, you cannot drive a car’s
engineering drawings. Before you can drive a car, it must be built from the engineering
drawings that describe it. A completed car has an actual accelerator pedal to make it go
faster, but even that’s not enough—the car won’t accelerate on its own (hopefully!), so the
driver must press the pedal to accelerate the car.

1.8.2 Methods and Classes
Let’s use our car example to introduce some key object-oriented programming concepts.
Performing a task in a program requires a method. The method houses the program state-
ments that actually perform its tasks. The method hides these statements from its user, just
as the accelerator pedal of a car hides from the driver the mechanisms of making the car
go faster. A program unit called a class houses the methods that perform the class’s tasks.
For example, a class that represents a bank account might contain one method to deposit
money to an account, another to withdraw money from an account and a third to inquire
what the account’s current balance is. A class is similar in concept to a car’s engineering
drawings, which house the design of an accelerator pedal, steering wheel, and so on. 

1.8.3 Instantiation 
Just as someone has to build a car from its engineering drawings before you can actually
drive a car, you must build an object of a class before a program can perform the tasks that
the class’s methods define. The process of doing this is called instantiation. An object is
then referred to as an instance of its class. 

1.8.4 Reuse
Just as a car’s engineering drawings can be reused many times to build many cars, you can
reuse a class many times to build many objects. Reuse of existing classes when building new
classes and programs saves time and effort. Reuse also helps you build more reliable and
effective systems, because existing classes and components often have gone through exten-
sive testing, debugging and performance tuning. Just as the notion of interchangeable parts
was crucial to the Industrial Revolution, reusable classes are crucial to the software revolu-
tion that has been spurred by object technology.

1.8.5 Messages and Method Calls
When you drive a car, pressing its gas pedal sends a message to the car to perform a task—that
is, to go faster. Similarly, you send messages to an object. Each message is a method call
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that tells a method of the object to perform its task. For example, a program might call a
particular bank-account object’s deposit method to increase the account’s balance. 

1.8.6 Attributes and Instance Variables
A car, besides having capabilities to accomplish tasks, also has attributes, such as its color,
its number of doors, the amount of gas in its tank, its current speed and its record of total
miles driven (i.e., its odometer reading). Like its capabilities, the car’s attributes are repre-
sented as part of its design in its engineering diagrams (which, for example, include an
odometer and a fuel gauge). As you drive an actual car, these attributes are carried along
with the car. Every car maintains its own attributes. For example, each car knows how
much gas is in its own gas tank, but not how much is in the tanks of other cars. 

An object, similarly, has attributes that it carries along as it’s used in a program. These
attributes are specified as part of the object’s class. For example, a bank-account object has
a balance attribute that represents the amount of money in the account. Each bank-
account object knows the balance in the account it represents, but not the balances of the
other accounts in the bank. Attributes are specified by the class’s instance variables.

1.8.7 Encapsulation
Classes encapsulate (i.e., wrap) attributes and methods into objects—an object’s attributes
and methods are intimately related. Objects may communicate with one another, but
they’re normally not allowed to know how other objects are implemented—implementa-
tion details are hidden within the objects themselves. This information hiding is crucial to
good software engineering. 

1.8.8 Inheritance
A new class of objects can be created quickly and conveniently by inheritance—the new class
absorbs the characteristics of an existing one, possibly customizing them and adding unique
characteristics of its own. In our car analogy, a “convertible” certainly is an object of the more
general class “automobile,” but more specifically, the roof can be raised or lowered. 

1.8.9 Object-Oriented Analysis and Design (OOAD)
How will you create the code for your programs? Perhaps, like many programmers, you’ll
simply turn on your computer and start typing. This approach may work for small pro-
grams, but what if you were asked to create a software system to control thousands of au-
tomated teller machines for a major bank? Or suppose you were asked to work on a team
of 1,000 software developers building the next U.S. air traffic control system? For projects
so large and complex, you should not simply sit down and start writing programs.

To create the best solutions, you should follow a detailed analysis process for deter-
mining your project’s requirements (i.e., defining what the system is supposed to do) and
developing a design that satisfies them (i.e., deciding how the system should do it). Ideally,
you’d go through this process and carefully review the design (and have your design
reviewed by other software professionals) before writing any code. If this process involves
analyzing and designing your system from an object-oriented point of view, it’s called an
object-oriented analysis and design (OOAD) process. Languages like Java are object ori-
ented. Programming in such a language, called object-oriented programming (OOP),
allows you to implement an object-oriented design as a working system. 
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1.9 Test-Driving the Doodlz App in an Android Virtual 
Device (AVD)
In this section, you’ll run and interact with your first Android app. The Doodlz app allows
you to drag your fingers on the screen to “paint.” You can control the brush sizes and col-
ors using options provided in the app’s options menu. There is no need to look at the app’s
code—you’ll build the app and study its code in Chapter 7.

The following steps show how to import the app’s project into Eclipse and how to
test-drive the app in the Nexus 4 Android Virtual Device (AVD) that you set up in the
Before You Begin section following the Preface. Later in this section, we’ll also discuss how
to run the app on a tablet AVD and on an Android device. When the app is running in
an AVD, you can create a new painting by “dragging your finger” anywhere on the canvas.
You “touch” the screen by using the mouse. 

Android SDK/ADT Bundle and Android Studio IDEs
The IDE screen captures in the following steps (and throughout this book) were taken on
a computer running Windows 7, the Java SE 7 JDK and the Android SDK/ADT Bundle
that you installed in the Before You Begin section. Because Android Studio is an early ac-
cess version and will be evolving rapidly, we provide the Android Studio instructions for
this test-drive on the book’s website 

This will enable us to update the instructions in response to Google’s changes. Both the
Android SDK/ADT Bundle and Android Studio use the same Android emulator, so once
an app is running in an AVD, the steps are identical.

1.9.1 Running the Doodlz App in the Nexus 4 Smartphone AVD
To test-drive the Doodlz app, perform the following steps:

1. Checking your setup. If you have not done so already, perform the steps specified
in the Before You Begin section located after the Preface.

2. Opening Eclipse. Open the eclipse subfolder of the Android SDK/ADT bun-
dle’s installation folder, then double click the Eclipse icon (  or , depending
on your platform). 

3. Specifying your workspace location. When the Workspace Launcher window ap-
pears, specify where you’d like the apps that you create to be stored, then click
OK. We used the default location—a folder named workspace in your user direc-
tory. A workspace is a collection of projects, and each project is typically an app
or a library that can be shared among apps. Each workspace also has its own set-
tings, such as where various Eclipse subwindows are displayed. You can have
many workspaces and switch between them for different development tasks—for
example, you could have separate workspaces for Android app development, Java
app development and web app development, each with its own custom settings.
If this is your first time opening Eclipse, the Welcome page (Fig. 1.14) is dis-
played.     

www.deitel.com/books/AndroidHTP2
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4. Launching the Nexus 4 AVD. For this test-drive, we’ll use the Nexus 4 smart-
phone AVD that you configured for Android 4.4 (KitKat) in the Before You Be-
gin section—in Section 1.9.2, we’ll show the app running in a tablet AVD. An
AVD can take several minutes to load, so you should launch it in advance of
when you intend to use it and keep it running in the background while you’re
building and testing your apps. To launch the Nexus 4 AVD, select Window > An-
droid Virtual Device Manager to display the Android Virtual Device Manager dialog
(Fig. 1.15). Select the Nexus 4 AVD for Android KitKat and click Start…, then
click the Launch button in the Launch Options dialog that appears. You should
not attempt to execute the app until the AVD finishes loading. Once the AVD
appears as shown in Fig. 1.16, unlock the AVD by dragging the mouse pointer
from the lock icon to the edge of the screen.   

Fig. 1.14 | Welcome page in Eclipse.

Fig. 1.15 | Android Virtual Device Manager dialog.
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5. Importing the Doodlz app’s project. Select File > Import… to open the Import dialog
(Fig. 1.17(a)). Expand the General node and select Existing Projects into Work-
space, then click Next > to proceed to the Import Projects step (Fig. 1.17(b)).
Click the Browse… button to the right of the Select root directory textbox. In the

Fig. 1.16 | Nexus 4 AVD home screen (for Android 4.4) when the AVD finishes loading.

Fig. 1.17 | Importing an existing project. (Part 1 of 2.)

Drag the mouse pointer  
from the lock icon to 
the edge of the screen 
to unlock the AVD

a) Import dialog
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Browse For Folder dialog, locate the Doodlz folder in the book’s examples folder,
select it and click Open. Click Finish to import the project into Eclipse. The proj-
ect now appears in the Package Explorer window (Fig. 1.18) at the left side of
Eclipse. If the Package Explorer window is not visible, you can view it by selecting
Window > Show View > Package Explorer.  

6. Launching the Doodlz app. In Eclipse, right click the Doodlz project in the Pack-
age Explorer window, then select Run As > Android Application (Fig. 1.19). This
will execute Doodlz in the AVD that you launched in Step 4 (Fig. 1.20).       

Fig. 1.18 | Package Explorer window.

Fig. 1.17 | Importing an existing project. (Part 2 of 2.)

b) Import dialog’s
Import Projects step
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Fig. 1.19 | Launching the Doodlz app.

Fig. 1.20 | Doodlz app running in the Android Virtual Device (AVD).

Recent apps button

Home button

Back button

App bar Options menu

Status bar

Navigation bar
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7. Exploring the AVD and immersive mode. At the AVD screen’s bottom are vari-
ous soft buttons that appear on the device’s touch screen. You touch these (by
using the mouse in an AVD) to interact with apps and the Android OS. The back
button goes back to the app’s prior screen, or back to a prior app if you’re in the
current app’s initial screen. The home button returns you to the device’s home
screen. The recent apps button allows you to view the recently used apps list, so
that you can switch back to them quickly. At the screen’s top is the app’s app bar,
which displays the app’s icon and name and may contain other app-specific soft
buttons—some appear on the app bar (COLOR and LINE WIDTH in Fig. 1.20) and
the rest appear in the app’s options menu ( ). The number of options on the app
bar depends on the size of the device—we discuss this in Chapter 7. Android 4.4
supports a new immersive mode that enables apps to use the entire screen. In this
app, you can tap once in the white drawing area to hide the device’s status and
navigation bars as well as the app’s action bar. You can redisplay these by tapping
the drawing area again or by swiping from the top edge of the screen. 

8. Understanding the app’s options. To display the options that do not appear on
the app bar, touch (i.e., click) the options menu ( ) icon. Figure 1.21(a) shows
the action bar and options menu on the Nexus 4 AVD and Fig. 1.21(b) shows
them on a Nexus 7 AVD—options shown on the action bar appear in small cap-
ital letters. Touching COLOR displays a GUI for changing the line color. Touch-
ing LINE WIDTH displays a GUI for changing the thickness of the line that will be
drawn. Touching Eraser sets the drawing color to white so that as you draw over
colored areas, the color is erased. Touching Clear first confirms whether you wish
to erase the entire image, then clears the drawing area if you do not cancel the
action. Touching Save Image saves the image into the device’s Gallery of images.
On Android 4.4, touching Print displays a GUI for selecting an available printer
so can print your image or save it as a PDF document (the default). You’ll explore
each of these options momentarily. 

Fig. 1.21 | Doodlz options menu expanded.

Doodlz options menu 
contents—on tablet 
AVDs and devices, 
some of these options 
might appear directly 
on the action bar

Drawing area

a) Action bar and
expanded

options menu on
a Nexus 4 AVD

b) Action bar
and expanded

options menu on
a Nexus 7 AVD
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9. Changing the brush color to red. To change the brush color, first touch COLOR on
the action bar to display the Choose Color dialog (Fig. 1.22). Colors are defined us-
ing the ARGB color scheme in which the alpha (i.e., transparency), red, green and
blue components are specified by integers in the range 0–255. For alpha, 0 means
completely transparent and 255 means completely opaque. For red, green and blue, 0
means none of that color and 255 means the maximum amount of that color. The
GUI consists of Alpha, Red, Green and Blue SeekBars that allow you to select the
amount of alpha, red, green and blue in the drawing color. You drag the SeekBars
to change the color. As you do, the app displays the new color below the SeekBars.
Select a red color now by dragging the Red SeekBar to the right as in Fig. 1.22.
Touch the Set Color button to return to the drawing area.

10. Changing the line width. To change the line width, touch LINE WIDTH on the ac-
tion bar to display the Choose Line Width dialog. Drag the SeekBar for the line
width to the right to thicken the line (Fig. 1.23). Touch the Set Line Width button
to return to the drawing area.

11. Drawing the flower petals. Tap the screen to enter immersive mode, then drag
your “finger”—the mouse when using the emulator—on the drawing area to
draw flower petals (Fig. 1.24).

Fig. 1.22 | Changing the drawing color to red.

Fig. 1.23 | Changing the line thickness.

Set Color button

SeekBars for changing
the alpha (transparency),

red, green and blue
components of the color

Current color (red)

SeekBar for line width

Current line width in the
current drawing color (red)

Set Line Width button
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12. Changing the brush color to dark green. Tap the screen to leave immersive mode
then touch COLOR to display the Choose Color dialog. Select a dark green color
by dragging the Green SeekBar to the right and ensuring that the Red and Blue
SeekBars are at the far left (Fig. 1.25(a)). 

13. Changing the line width and drawing the stem and leaves. Touch LINE WIDTH to
display the Choose Line Width dialog. Drag the SeekBar for the line width to the
right to thicken the line (Fig. 1.25(b)). Tap the screen to re-enter immersive

Fig. 1.24 | Drawing flower petals.

Fig. 1.25 | Changing the color to dark green and making the line thicker.

a) Selecting dark green as the drawing color b) Selecting a thicker line
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mode, then draw the flower stem and leaves. Repeat Steps 12 and 13 for a lighter
green color and thinner line, then draw the grass (Fig. 1.26).

14. Finishing the drawing. Tap the screen to exit immersive mode. Next, change the
drawing color to blue (Fig. 1.27(a)) and select a narrower line (Fig. 1.27(b)).
Then tap the screen to enter immersive mode and draw the raindrops (Fig. 1.28).

Fig. 1.26 | Drawing the stem and grass.

Fig. 1.27 | Changing the line color to blue and narrowing the line.

a) Selecting blue as the drawing color b) Selecting a thinner line
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15. Saving the image. You can save your image to the device’s Gallery app by selecting
Save from the options menu . You can then view this image and others stored
on the device by opening the Gallery app. 

16. Printing the image. To print the image, select Print from the options menu. This
displays the print dialog, which allows you to save the image as a PDF document
by default. To select a printer, tap Save as PDF and select from the available print-
ers. If no printers appear in the list, you may need to configure Google Cloud
Print for your printer. For information on this, visit

17. Returning to the home screen. You can return to the AVD’s home screen by tap-
ping the home ( ) button on the AVD. To view the drawing in the Gallery app
touch  to display the list of apps installed on the AVD. You can then open
the Gallery app to view the drawing.

1.9.2 Running the Doodlz App in a Tablet AVD
To test the app in a tablet AVD, first launch the AVD by performing Step 4 in
Section 1.9.1, but select the Nexus 7 AVD rather than the Nexus 4 AVD. Next, right click
the Doodlz project in Eclipse’s Package Explorer window and select Run As > Android Ap-
plication. If multiple AVDs are running when you launch an app, the Android Device
Chooser dialog (Fig. 1.29) appears so that you can choose the AVD on which to install
and execute the app. In this case, both the Nexus 4 and Nexus 7 AVDs were running on
our system, so there were two Android virtual devices on which we could possibly run the

Fig. 1.28 | Drawing the rain in the new line color and line width.

     http://www.google.com/cloudprint/learn/
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app. Select the Nexus 7 AVD and click OK. This app runs in portrait orientation (the
width is less than the height) on phone and small tablet devices. If you run the app on a
large tablet AVD (or large tablet device) the app runs in landscape orientation (the width
is greater than the height). Figure 1.30 shows the app running in the Nexus 7 AVD. If the
AVD is too tall to display on your screen, you can change the AVD’s orientation by typing
Ctrl + F12 (on a Mac use fn + control + F12). On some keyboards the Ctrl key is labeled
Control.    

Fig. 1.29 | Android Device Chooser dialog.

Fig. 1.30 | Drawing in the Nexus 7 AVD.
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1.9.3 Running the Doodlz App on an Android Device
If you have an Android device, you can easily execute an app on it for testing purposes. 

1. Enabling the developer options on the device. First, you must enable debugging
on the device. To do so, go to the device’s Settings app, then select About phone,
(or About tablet) locate the Build number (at the bottom of the list) and tap it re-
peatedly until you see the message You are now a developer on the screen. This
will enable an entry named Developer options to the Settings app. 

2. Enabling debugging on the device. Return to the Settings app, select Developer
options and ensure that USB debugging is checked—this is the default when you
first enable the developer options on the device.

3. Connecting your device. Next, connect the device to your computer via the USB
cable that came with your device. If you’re a Windows user, recall from the Before
You Begin section that you might need to install a USB driver for your device.
See the following two web pages for details: 

4. Running Doodlz on the Android device. In Eclipse, right click the Doodlz project
in the Package Explorer window, then select Run As > Android Application. If you
do not have any AVDs open, but do have an Android device connected, the IDE
will automatically install the app on your device and execute it. If you have one
or more AVDs open and/or devices connected, the Android Device Chooser dia-
log (Fig. 1.29) is displayed so that you can select the device or AVD on which to
install and execute the app. 

Preparing to Distribute Apps
When you build apps for distribution via app stores like Google Play, you should test the
apps on as many actual devices as you can. Remember that some features can be tested only
on actual devices. If you don’t have many devices available to you, create AVDs that sim-
ulate the various devices on which you’d like your app to execute. When you configure
each AVD to simulate a particular device, look up the device’s specifications online and
configure the AVD accordingly. In addition, you can modify the AVD’s config.ini file
as described in the section Setting hardware emulation options at 

This file contains options that are not configurable via the Android Virtual Device Manager.
Modifying these options allows you to more precisely match the hardware configuration
of an actual device. 

1.10 Building Great Android Apps
With over 800,000 apps in Google Play,9 how do you create an Android app that people will
find, download, use and recommend to others? Consider what makes an app fun, useful, in-

    developer.android.com/tools/device.html
    developer.android.com/tools/extras/oem-usb.html

developer.android.com/tools/devices/
   managing-avds-cmdline.html#hardwareopts

9. http://www.pureoxygenmobile.com/how-many-apps-in-each-app-store/.
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teresting, appealing and enduring. A clever app name, an attractive icon and an engaging de-
scription might lure people to your app on Google Play or one of the many other Android
app marketplaces. But once users download the app, what will make them use it regularly
and recommend it to others? Figure 1.31 shows some characteristics of great apps.

Characteristics of great apps

Great Games

• Entertaining and fun.

• Challenging. 

• Progressive levels of difficulty.

• Show your scores and use leaderboards to record high scores.

• Provide audio and visual feedback.

• Offer single-player, multiplayer and networked versions.

• Have high-quality animations.

• Offloading input/output and compute-intensive code to separate threads of execution 
to improve interface responsiveness and app performance.

• Innovate with augmented reality technology—enhancing a real-world environment 
with virtual components; this is particularly popular with video-based apps.

Useful Utilities

• Provide useful functionality and accurate information.

• Increase personal and business productivity.

• Make tasks more convenient (e.g., maintaining a to-do list, managing expenses).

• Make the user better informed.

• Provide topical information (e.g., the latest stock prices, news, severe storm warnings, 
traffic updates).

• Use location-based services to provide local services (e.g., coupons for local businesses, 
best gas prices, food delivery).

General Characteristics

• Up-to-date with the latest Android features, but compatible with multiple Android ver-
sions to support the widest possible audience.

• Work properly.

• Bugs are fixed promptly.

• Follow standard Android app GUI conventions.

• Launch quickly.

• Are responsive. 

• Don’t require too much memory, bandwidth or battery power.

• Are novel and creative.

• Enduring—something that your users will use regularly.

• Use professional-quality icons that will appear in Google Play and on the user’s device.

Fig. 1.31 | Characteristics of great apps. (Part 1 of 2.)
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1.11 Android Development Resources
Figure 1.32 lists some of the key documentation from the Android Developer site. As you
dive into Android app development, you may have questions about the tools, design is-
sues, security and more. There are several Android developer newsgroups and forums
where you can get the latest announcements or ask questions (Fig. 1.33). Figure 1.34 lists
several websites where you’ll find Android development tips, videos and resources.   

General Characteristics (cont.)

• Use quality graphics, images, animations, audio and video.

• Are intuitive and easy to use (don’t require extensive help documentation).

• Accessible to people with disabilities (http://developer.android.com/guide/topics/
ui/accessibility/index.html).

• Give users reasons and a means to tell others about your app (e.g., you can give users the 
option to post their game scores to Facebook or Twitter).

• Provide additional content for content-driven apps (e.g., game levels, articles, puzzles).

• Localized (Chapter 2) for each country in which the app is offered (e.g., translate the 
app’s text and audio files, use different graphics based on the locale, etc.). 

• Offer better performance, capabilities and ease-of-use than competitive apps.

• Take advantage of the device’s built-in capabilities.

• Do not request excessive permissions.

• Are designed to run optimally across a broad variety of Android devices.

• Future-proofed for new hardware devices—specify the exact hardware features your app 
uses so Google Play can filter and display it for only compatible devices 
(http://android-developers.blogspot.com/2010/06/future-proofing-your-app.html).

 Title URL

App Components http://developer.android.com/guide/components/

index.html  

Using the Android Emulator http://developer.android.com/tools/devices/

emulator.html 

Package Index http://developer.android.com/reference/

packages.html 

Class Index http://developer.android.com/reference/

classes.html 

Android Design http://developer.android.com/design/index.html 

Fig. 1.32 | Key online documentation for Android developers. (Part 1 of 2.)

Characteristics of great apps

Fig. 1.31 | Characteristics of great apps. (Part 2 of 2.)
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Data Backup http://developer.android.com/guide/topics/

data/backup.html  

Security Tips http://developer.android.com/training/

articles/security-tips.html  

Managing Projects from Eclipse with 
ADT

http://developer.android.com/guide/developing/

projects/projects-eclipse.html  

Getting Started with Android Studio http://developer.android.com/sdk/installing/

studio.html  

Debugging http://developer.android.com/tools/debugging/

index.html 

Tools Help http://developer.android.com/tools/help/

index.html 

Performance Tips http://developer.android.com/training/

articles/perf-tips.html 

Keeping Your App Responsive http://developer.android.com/training/

articles/perf-anr.html 

Launch Checklist (for Google Play) http://developer.android.com/distribute/

googleplay/publish/preparing.html 

Get Started with Publishing http://developer.android.com/distribute/

googleplay/publish/register.html 

Managing Your App’s Memory http://developer.android.com/training/

articles/memory.html 

Google Play Developer 
Distribution Agreement

http://play.google.com/about/

developer-distribution-agreement.html 

Title Subscribe Description

Android Discuss Subscribe using Google Groups: 
android-discuss

Subscribe via e-mail: 
android-discuss-

subscribe@googlegroups.com

A general Android discussion group 
where you can get answers to your app-
development questions.

Stack Overflow http://stackoverflow.com/

questions/tagged/android
Use this list for beginner-level Android 
app-development questions, including 
getting started with Java and Eclipse, and 
questions about best practices.

Android Developers http://groups.google.com/

forum/?fromgroups#!forum/

android-developers 

Experienced Android developers use this 
list for troubleshooting apps, GUI design 
issues, performance issues and more.

Fig. 1.33 | Android newsgroups and forums. (Part 1 of 2.)

 Title URL

Fig. 1.32 | Key online documentation for Android developers. (Part 2 of 2.)
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Android Forums http://www.androidforums.com Ask questions, share tips with other 
developers and find forums targeting spe-
cific Android devices.

Android development tips, videos and 
resources URL

Sample Android apps from Google http://code.google.com/p/apps-for-

android/ 

O’Reilly article, “Ten Tips for Android 
Application Development” 

http://answers.oreilly.com/topic/

862-ten-tips-for-android-application-

development/ 

Bright Hub™ website for Android pro-
gramming tips and how-to guides

http://www.brighthub.com/mobile/

google-android.aspx  

The Android Developers Blog http://android-developers.blogspot.com/ 

The Sprint® Application Developers 
Program

http://developer.sprint.com/site/

global/develop/mobile_platforms/

android/android.jsp 

HTC’s Developer Center for Android http://www.htcdev.com/ 

The Motorola Android development site http://developer.motorola.com/ 

Top Android Users on Stack Overflow http://stackoverflow.com/tags/android/

topusers 

AndroidDev Weekly Newsletter http://androiddevweekly.com/ 

Chet Haase’s Codependent blog http://graphics-geek.blogspot.com/ 

Cyril Mottier’s Android blog http://cyrilmottier.com/ 

Romain Guy’s Android blog http://www.curious-creature.org/

category/android/ 

Android Developers Channel on YouTube® http://www.youtube.com/user/

androiddevelopers 

Android Video Playlists http://developer.android.com/develop/

index.html 

What’s New in Android Developer Tools http://www.youtube.com/

watch?v=lmv1dTnhLH4 

Google I/O 2013 Developer 
Conference session videos

http://developers.google.com/events/io/

sessions 

Fig. 1.34 | Android development tips, videos and resources.

Title Subscribe Description

Fig. 1.33 | Android newsgroups and forums. (Part 2 of 2.)
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